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What We Will Cover

* Accessibility Guidelines

* Publishing Guidelines
— Content
— Copyright

e Style Guidelines



Accessibility Principles - Perceivable

Perceivable: Web content is made available to
the senses—sight, hearing, and/or touch.

1. Perceivable information and user interface.

1. Text alternatives for non-text content.

N

Captions and other alternatives for multimedia.

w

Content can be presented in different ways.

=

Content is easier to see and hear.



Accessibility Principles - Operable

Operable: Interface forms, controls, and
navigation are operable.

2. Operable user interface and navigation.

1.
2.

Functionality is available from a keyboard.

Users have enough time to read and use the
content.

Content does not cause seizures.

Users can easily navigate, find content, and
determine where they are.



Accessibility Principles -
Understandable

Understandable: Content and interface are
understandable.

3. Understandable information and user
interface

1. Textis readable and understandable.

2. Content appears and operates in predictable
ways.

3. Users are helped to avoid and correct mistakes.



Accessibility Principles - Robust

Robust: Content can be used by a wide variety
of user agents, including assistive technologies.
4. Robust content and reliable interpretation.

1. Content is compatible with current and future
user tools.



Accessibility Features &
Assistive Technologies

Page Titles
Headings
_ISts

Links

Alt Text for Images

Readable Content/Plain Language Writing
Font Styles (Not used by some technologies.)



Page Titles

Often the first thing read by a screen reader.
Should be succinct and descriptive.

Put the most useful information first.
Should match or be similar to the <h1>.



Headings

The most common method for finding
information on a page for screen reader users.

Headings serve as a table of contents.
Should describe a section of content.
Should never be empty

Usually one <h1> per page. Similar to page title.
Do not skip heading levels (e.g., <h2> to <h4>).
Can skip backward (e.g., <h4> to <h2>).

Use built-in tools to create headings.




Lists

Use lists appropriately.
e <ol> for ordered, hierarchical/numbered lists.

e <ul>for unordered, bulleted lists.
e Use built-in tools to create lists.



Links

Screen readers lists links out of context.

Links should be descriptive. Describe where the link
goes.

Avoid using generic phrases such as "click here."

Web addresses or URLs are not considered informative
and should not be used.

Open in the same window. Do not disable the back
button. Opening in new window can be disorienting.

Do not use the Tooltip or Title attribute. It can be
distracting.



Alt Text for Images

Allows screen readers to convert the image into words.
Indexes images for searching.

Should be clear, concise, descriptive.

Do not use the same text for every image.

Avoid unrelated images or decorative text in images.
All text in an image must be written as alternative text.

Infographics should have written narrative equivalent
to the graphic. Provide a link to the text alternative.



Write Readable Content

Ensure sentences are 20 words or less: Easier to read.
Use shorter words when possible: Less than four syllables.

Avoid using jargon: Only use when appropriate for the target
audience.

Use personal pronouns when appropriate: Use ‘we, ‘our,” ‘you,” and
‘vour’ to shorten your writing and make it flow better.

Add transitions: Use transition words and phrases, such as ‘overall,” ‘in
fact, ‘ultimately,” etc.,

Use headings to split up content: Headings provide structure and
meaning to your content and give readers an easy way to scan content.
People using assistive technologies like screen readers navigate online
by headings.



Readability Tools & Resources

* HemingwayApp.com

* PlainLanguage.gov — Website by government
employees to promote clear communication.

— PlainLanguage.gov/Guidelines

— PlainLanguage.gov/Training/Videos



http://www.hemingwayapp.com/
http://www.plainlanguage.gov/howto/wordsuggestions/simplewords.cfm
https://plainlanguage.gov/guidelines/
https://plainlanguage.gov/training/videos/

Font Styles

Bold and /talics are not interpreted by screen
readers.

Avoid Underline style. It looks like a link.

Don’t apply font type, font color, or font size
changes to individual sections of text. It
overrides the style sheet.

Styles do not add meaning to screen reader
users.



Document Accessibility

Begins in the native document format.
Applications must be able to tag PDF output.
Word and PowerPoint tag PDF output.

Avoid Excel and Publisher. They do not tag PDF
files. Will have to add the tags with Acrobat.

Save as a PDF from Word and PowerPoint.
Do not Print to PDF.



Make Word Documents Accessible

Use Headings for Structure:

— Usually one H1

— Don’t skip levels. H2 follows H1, etc.

— Change heading styles, not heading levels.

Use Alt Text for Images.
dentify Heading row or column in Tables.
Use descriptive text links, not URLs.

Run the Accessibility Checker and correct
Errors.




Make PowerPoint Presentations
Accessible

Use pre-defined PowerPoint slide templates.

Slide titles provide heading structure for
screen reader users.

Reading order is based on how objects added
to slide. Check and update in Selection Pane.

Use Alternative Text for images.
Descriptive text links.

Run Accessibility Checker and fix errors.



Saving as a PDF for the Web

File > Save as...

Filename: Lowercase, no spaces, underscore in
place of spaces, describes file, ordered with like

files.

Author: Department, not a person.
Title: Title of the File in Title Case.
Type: PDF

Language: English (Tools > Save Options >
Language)



Accessibility Checklist for
Web Content Editors (1/2)

1. Use a built-in Heading tools for structure.

2. Use the built-in List tools for lists.
3. Add links and files using descriptive clickable

text and alternative text.

4. Add descriptive alternative text to images.

. Only use tables for tabular data not display
structure.



Accessibility Checklist for
Web Content Editors (2/2)

6. Mark heading rows and/or columns on
tables.

7. All documents you upload, link or display on
your website should be accessible.

8. Embedded videos must include captioning.
9. Check reading level of content.
10.Check for high color contrast.



Content Guidelines (1/4)

No Blank Pages

Consistent Presentation

— Section and Page Layouts

— Accessibility Techniques

— Style Sheets (Avoid Applying Font Styles)

Main Navigation 6-8 items. Never leads
visitors away from the website.

School Brand — Logo, Colors



Content Guidelines (2/4)

e Links

— Do not use JPS email addresses on web pages. Do
not link to JPS email addresses. Contact forms
should replace these links.

— Avoid discriminatory, for profit, commercial,
political sites.

— Open in the same window to avoid disabling the
functionality of the Back button.



Content Guidelines (3/4)

* |mages
— Only use if they support page content.
— Add the alt text.

— Optimize for the web using a photo editor like
Pixlr.com

— Do not violate copyright. Search 1,000s of
copyright free images at CreativeCommons.org &
Pixabay.com.



Content Guidelines 4/4

* File Names
— Short but descriptive. Use keywords.
— Use lowercase letters, numbers.
— No spaces.
— Avoid using dates. Overwrite old files.

— Employ techniques that allow automatic sorting in
the file management system.

— If dates used for sorting, use format: yyyy_ mm_dd
to keep them in order. Best if archiving.



Copyright

* "Copyright" literally means the right to copy
but has come to mean that body of exclusive
rights granted by law to copyright owners for
protection of their work.

* Most common type of copyright infringement
is copying images and using them on a
website.



Fair Use

* The legal right to use copyrighted images (or
other works of authorship) as long as the

images are used for educational, research, or

personal use, for as long as the image benefits
the public good in some way.



Creative Commons

* I[mages that are copyrighted but that the
creator has put provisions on their use. A
creative commons license might stipulate, for
example, that an image can be used as long as

it is not modified in any way.



Public Domain

* Images that no longer have copyright
restrictions either because the creator
willingly relinquished their copyright or
because the creator is dead and no one owns
the copyright.



Social Media Images

* Unethical to re-distribute an image that the
poster did not intend to go public.

e Plagiarism to post an image (or other work of
authorship) without citing the source.

e Best practice to link back to the source.



You Can Use an Image If...

1. You own the copyright.
2. It falls under fair use.
3. It has a creative commons license.

4. It’s in the public domain.



You Own the Copyright

* You took the created the work yourself.

* You asked for and were granted permission to
use the work.

* You purchased the rights to use the work.



Image Is Under Fair Use

Used to teach, analyze, or parody.
Published for the public good.
Used the work sparingly.

Did not profit from using the work.



Image Has A Creative Commons
License

Attribution should be given to the creator.
Abide by the creator’s license agreement.

CreativeCommons.org — search Google,
Pixabay and CCO images.



It’s In The Public Domain

 Over 120 years old.
 Owner relinquished ownership.
 Owner has been dead for more than 70 years.



Copyright Resource & More Info

e The Visual Communication Guy, Can | Use That
Picture?

e U.S. Copyright Office



http://thevisualcommunicationguy.com/2014/07/14/can-i-use-that-picture/
https://www.copyright.gov/

Copyright Free Images

CreativeCommons.org Search

Pexels.com

Pixabay.com

WikimediaCommons.org



https://search.creativecommons.org/
https://www.pexels.com/
https://pixabay.com/
https://commons.wikimedia.org/

AP Style Guide—A

 ABCs—But single-letter grades get apostrophes: an A, two B's
and three C's.

* academic degrees—Spell out and capitalize with no
apostrophe formal degrees Bachelor of Arts, Bachelor of
Science, Master of Arts, and Master of Science. But bachelor’s
and master’s should appear with an apostrophe. An associate
degree should not have an apostrophe.

* acronyms—Should be fully spelled out on first reference. The
acronym should appear in parentheses on first reference and
appear without parentheses thereafter. Ex. Students will
participate in multiple Advanced Placement (AP) courses.



AP Style Guide—B

back-to-school (adj.)—He bought back-to-school supplies. But
she went back to school.

Board Meetings—Always capitalize formal meetings of the
Board of Trustees, including Business Meeting, Work Session,
Special Called Business Meeting and all committee meetings.

Board Members—Each elected member of the SCBE is
referred to as a Board Member. Board is always capitalized.

book titles—Capitalize and enclose in quotes the names of
books, poems, plays, films and songs. Capitalize without
guotes books that are primarily references.

bus, buses—Not busses.



AP Style Guide—C/D

classroom—One word.

courses—Capitalize proper noun elements or numbered
courses: American history, English, Algebra 1, world history.

courtesy titles—Do not use courtesy titles, such as Mr., Mrs.,
Miss or Ms unless quoted. Do use Dr.

days, months, years—Capitalize them. Spell out. Use the days
of the week, not today or tonight, in print copy. Abbreviate in
three-letter format days and months in tables.

District—Capitalize District when it is used as a formal
replacement for Jackson Public Schools.

dropout (n.), drop out (v.)



AP Style Guide—E

e-book—electronic version of a book or publication.

e-reader—Also e-book reader. Device used to display
electronic books or other digital publications.

email—Electronic mail
enroll, enrolled, enrolling

events—Titles of special events, such as school fundraisers,
are capitalized and enclosed in quotes.



AP Style Guide—G

GPA—Acceptable in all references for grade-point average.

grade, grader— Use figures for grades 10 and above. Spell out
one through nine, such as ninth grade. Exceptions apply for
data in tables. Use figures for all grades in tables.

Hyphenate first-grader, seventh-grader, 10th-grader; also,
first-grade student, 11th-grade classes are hyphenated as
combining forms. But: She is in the fifth grade.

graduate (v.)—Graduate is correctly used in the active voice:
She graduated from high school. It is correct, but unnecessary,
to use the passive voice: He was graduated from high school.
Do not, however, drop from: John Adams graduated from
Harvard. Not: John Adams graduated Harvard.



AP Style Guide—Holidays

Capitalize.

New Year's Eve/New Year’s Day (Dec. 31 & Jan. 1)
Martin Luther King Jr. Day (third Monday in January)
Easter (Dates vary based on March equinox)
Good Friday (Dates vary based on Easter)
Memorial Day (last Monday in May)
Independence Day (July 4)

Labor Day (first Monday in September)

Veterans Day (Nov. 11)

Thanksgiving (fourth Thursday in November)
Christmas (Dec. 25)



AP Style Guide—J/K

job titles—Only Superintendent and executive-level positions
should be capitalized when referring to a specific person.
Principal is capitalized when used as a formal title for a
specific individual. Do not capitalize any job titles in general
references. Ex. Superintendent John Smith; John Smith was the
superintendent.

JPS—Abbreviation for Jackson Public Schools or the Jackson
Public School District.

K-12—The years of schooling from kindergarten through 12th
grade graduation. But pre-K through grade 12.

kindergarten, kindergartners



AP Style Guide—Miilitary Titles

general-Gen.

lieutenant general-Lt. Gen.
major general—-Maj. Gen.
brigadier general-Brig. Gen.
colonel—Col.

lieutenant colonel-Lt. Col.
major—Maj.

captain—Capt.

first lieutenant—1st Lt.
second lieutenant—2nd Lt.



AP Style Guide—N/P/R

No.—Use as the abbreviation for number in conjunction with
a figure to indicate position or rank: No. 1 man, No. 3 choice.

parent-teacher conferences—Hyphenate.

PTA—Acceptable in all references for Parent Teacher
Association

public schools—Use a figure and capitalize when numbered:
Public School 3. If a school has a commemorative name,
capitalize it: Benjamin Franklin School.

phone numbers—We use parentheses around area codes on
the website for consistency. Ex. (601) 960-8700. AP now uses
the hyphenated format.

room numbers—Use figures and capitalize room when used
with a figure: Room 2, Room 211.



AP Style Guide—S/Teacher

school day—Two words for any day that school is in session.

school year—The 2017-18 school year begins soon. 2017-
2018 is also acceptable.

schoolwork—One word.
spring break—Lowercase unless used as a title.

teacher—One word for schoolteacher; others are three words
without hyphens: grade school teacher, high school teacher



AP Style Guide—-Times

Do not use PM, pm, or :00 when writing times on the hour.

Use a colon to separate hours from minutes:
11a.m., 1p.m., 3:30p.m.,,9-11a.m,,9a.m.to 5 p.m.

Use figures.
AP accepts 12 p.m. for noon and 12 a.m. for midnight.



AP Style Guide—Voicemail/Web

voicemail—one word

web—Short for World Wide Web. Also website, webcam,
webcast, webfeed, webmaster, webpage.
web address and web browser.



AP Writing Helps

e CapitalizeMyTitle.com

e Merriam-Webster.com



https://capitalizemytitle.com/
http://www.merriam-webster.com/

